
LAND USE AND LAND COVER CHANGE 
DETECTION: A TWENTY YEAR COMPARATIVE 

STUDY OF PASCO COUNTY, FLORIDA 

1 Introduction 
Our planets vegetation has changed as a result of the action of humans and its inactions as 
well. This change has affected food production with direct consequence (Julien et al 2011). 
Land use and land cover change has affected both humans and the physical environment and 
also plays a fundamental role in various environmental and socioeconomic applications from 
local to the global scales (Chunhao Zhu & Yingkui Li, 2013).  

The comparison of two to three land use maps over a long period of time is very vital to 
determine the trend and pattern of these land cover change (Chunhao Zhu & Yingkui Li, 2013). 
The interpretation of land use and land cover change involves some classification algorithms. 
Although the Maximum Likelihood Classifier is the most common method of classification 
(Chunhao Zhu & Yingkui Li, 2013), there are other types of classifiers such as the Minimum 
Distance Classifier. 

One major process in the Land Cover classification is to access for the accuracy of said 
classification. Li and Wang (2009) suggested that accuracies greater than 80 percent in overall 
accuracy was the ideal quality of the land cover changing detection. Zhu and Li (2013) also 
suggest that one effective way to assess accuracy is through the use of field work or surveys or 
the use of high resolution aerial photos to obtain ground reference data. Field survey and high 
resolution aerial photographs can be very expensive and time consuming (Chunhao Zhu & 
Yingkui Li, 2013), however, with the introduction of Google Earth and free high resolution 
satellite images provided through the internet, most areas within the United States and some 
parts of the world, it is now easier to conduct field surveys without leaving the comfort at home. 
As a result of this, high resolution images from Google Earth have provided ways to obtain 
ground reference data for assessment accuracy of land use and land cover classification 
(Chunhao Zhu & Yingkui Li, 2013, Clark & Aide, 2011). 

1.1 Aim and Objective 
The major goal for this project is to conduct a land cover chage analysis for Pasco County over 
a twenty year period to ascertain how much change has occurred over this period. 

Some of the objectives to accomplish this goal include: 

• Make a supervised classification of the 1993,1998, 2003 and 2008 Landsat TM satellite 
image data; 

• Make a supervised classification of 2013 Landsat OLI/TIRS satellite image data; 
• Compare all  classified images for changes; 
• Report any change in tables diagrams and figures. 

 



Study Area 

 
Figure 1: Map of Pasco County, Florida 

Pasco County, located in Florida, was created on June 2nd, 1887 from the southern part of 
Hernando County. It is named after Samuel Pasco who was elected to the US senate. New Port 
Richey is the largest city in the county and Dade City is the county seat. Pasco, Hernando, 
Hillsborough and Pinellas counties, make up the Tampa-St. Petersburg-Clearwater Metropolitan 
Statistical Area.  

Pasco County is bordered by Hernando County in the North, Sumter County in the Northeast, 
Polk County in the Southeast, Hillsborough County in the South and Pinellas County in the 
Southwest. Pasco County is regarded as one of the fastest growing counties in the country with 
a population of 464,697 according to the 2010 population census. The county is blessed with 
numerous parks and trails such as the Gulf of Mexico, and several nudist resorts. Pasco County 
has a total area of 865.95 square miles, with 744.85 square miles comprising of land and 
123.10 square mile comprising of water (“Pasco County, Florida,” 2015). 

2 Methodology 
2.1 Data 
The data used for this project was a 1993, 1998, 2003 and 2008 TM Landsat image and a 2013 
Operational Land Imager (OLI), commonly referred to as Landsat 8. Landsat 8 is a relatively 
new satellite image which was launched on February 11, 2013. Landsat 8 has eleven bands; 
nine of these bands are OLI spectral bands while the remaining two are thermal infrared sensor 
(TIRS) spectral bands.  The bands, wavelengths and resolutions of Landsat 8 is shown in the 



table below. The Thematic Mapper (TM) has 4 multispectral scanner bands and 7 thematic 
mapper bands. The thematic mapper bands have a higher resolution than the multispectral 
scanner which was the reason why it was chosen for my analysis in this project. All satellite 
images were downloaded from the US Geological Survey website. 

Table 1: Landsat 8 Operational Land Imager (OLI) and Thermal Infrared Sensor (TIRS) bands 
Spectral Band Wavelength Resolution 

Band 1 - Coastal / Aerosol 0.433 - 0.453 µm 30 m 

Band 2 - Blue 0.450 - 0.515 µm 30 m 

Band 3 - Green 0.525 - 0.600 µm 30 m 

Band 4 - Red 0.630 - 0.680 µm 30 m 

Band 5 - Near Infrared 0.845 - 0.885 µm 30 m 

Band 6 - Short Wavelength Infrared 1.560 - 1.660 µm 30 m 

Band 7 - Short Wavelength Infrared 2.100 - 2.300 µm 30 m 

Band 8 - Panchromatic 0.500 - 0.680 µm 15 m 

Band 9 - Cirrus 1.360 - 1.390 µm 30 m 

Band 10 - Long Wavelength Infrared 10.30 - 11.30 µm 100 m 

Band 11 - Long Wavelength Infrared 11.50 - 12.50 100 m 

Source: Wikipedia, 2014 

2.2 Method 
2.2.1 Supervised classification 
Supervised classification is a much more accurate method for mapping classes, but depends 
heavily on the cognition and skills of the image specialist. The strategy is simple: the specialist 
must recognize conventional classes (real and familiar) or meaningful (but somewhat artificial) 
classes in a scene from prior knowledge, such as, personal experience with the region, by 
experience with thematic maps, or by on-site visits. This familiarity allows the specialist to 
choose and set up discrete classes (thus supervising the selection) and the, assign them 
category names. The specialists also locate training sites on the image to identify the classes. 
Training sites are areas representing each known land cover category that appear fairly 
homogeneous on the image (as determined by similarity in tone or color within shapes 
delineating the category). Specialists locate and circumscribe them with polygonal boundaries 
drawn (using the computer mouse) on the image display. For each class thus outlined, mean 
values and variances of the DNs for each band used to classify them are calculated from all the 
pixels enclosed in the site. More than one polygon can be established for any class. When DNs 
are plotted as a function of the band sequence (increasing with wavelength), the result is a 
spectral signature or spectral response curve for that class. In reality the spectral signature is for 
all of the materials within the site that interact with the incoming radiation. Classification now 



proceeds by statistical processing in which every pixel is compared with the various signatures 
and assigned to the class whose signature comes closest. A few pixels in a scene do not match 
and remain unclassified, because these may belong to a class not recognized or defined) (“End 
to End Remote Sensing Tutorial Page 1-17,” n.d.). Using ENVI, training areas was used to 
extract Regions of Interests (ROIs). These ROIs were used to identify the five deferent classes 
to be used to the classification purposes, post classification and other purposes as the 
progressed. These classes include Built-Up Area, Forest, Wetlands, Grasslands, and Water. 

The maximum likelihood method of supervised classification was chosen for this classification. 
Maximum likelihood classification assumes that the statistics for each class in each band are 
normally distributed and calculates the probability that a given pixel belongs to a specific class. 
Unless a probability threshold is selected, all pixels are classified. Each pixel is assigned to the 
class that has the highest probability (i.e., the maximum likelihood). 

2.2.2 Post Classification 
Confusion Matrix (Use Ground Truth Regions of Interest) 

This involves the use of the ground truth ROIs generated to calculate and display the confusion 
matrix. This report pairs ROIs with the classes of a classification image to show what 
percentage of the ROI pixels were or were not contained in a resulting class. To display a 
confusion matrix report using ROIs for ground truth: 

1. From the Toolbox, select Classification > Post Classification > Confusion Matrix 
Using Ground Truth ROIs. The Classification Input File dialog appears. 

2. Select a classification input file and perform optional spatial and spectral subsetting, then 
click OK. The Ground Truth Input File dialog appears. 

3. Select a ground truth classification input file and perform optional spatial and spectral 
subsetting, then click OK. The Match Classes Parameters dialog appears. 

4. Match the ground truth ROIs with the classification result classes by selecting the 
matching names in the two lists and clicking Add Combination. The class combinations 
are shown in a list at the bottom of the dialog. If the ground truth and classification 
classes have the same names, they are automatically matched. 

To remove a class match from the list, select the combination name. The two class names 
reappear in the lists at the top of the dialog. 

5. Click OK. The Confusion Matrix Parameters dialog appears. 

6. Select the Pixels and/or the Percent check boxes. 

7. Click the Yes or No toggle for Report Accuracy Assessment. 

8. Enter an output error filename, and click OK. 

The report shows the overall accuracy, kappa coefficient, confusion matrix, errors of 
commission (percentage of extra pixels in class), errors of omission (percentage of pixels left 
out of class), producer accuracy, and user accuracy for each class. Producer accuracy is the 
probability that a pixel in the classification image is put into class x given the ground truth class 

http://www.exelisvis.com/docs/subsetting.html
http://www.exelisvis.com/docs/subsetting.html


is x. User Accuracy is the probability that the ground truth class is x given a pixel is put into 
class x in the classification image. The confusion matrix output shows how the accuracy 
assessments are calculated (“Calculate Confusion Matrices (Using ENVI) | Exelis VIS Docs 
Center,” n.d.). 

Overall Accuracy 

The overall accuracy is calculated by summing the number of pixels classified correctly and 
dividing by the total number of pixels. The ground truth image or ground truth ROIs define the 
true class of the pixels. The pixels classified correctly are found along the diagonal of the 
confusion matrix table which lists the number of pixels that were classified into the correct 
ground truth class. The total number of pixels is the sum of all the pixels in all the ground truth 
classes. The overall accuracy was calculated for all classified satellite images. The results are 
shown in the results and analysis section of this report (“Calculate Confusion Matrices (Using 
ENVI) | Exelis VIS Docs Center,” n.d.). 

Kappa Coefficient 

The kappa coefficient (κ) is another measure of the accuracy of the classification. It is calculated 
by multiplying the total number of pixels in all the ground truth classes (N) by the sum of the 
confusion matrix diagonals (xkk), subtracting the sum of the ground truth pixels in a class times 
the sum of the classified pixels in that class summed over all classes (), and dividing by the total 
number of pixels squared minus the sum of the ground truth pixels in that class times the sum of 
the classified pixels in that class summed over all classes. The results from the calculated 
kappa coefficients are shown in the results and analysis section of this report (“Calculate 
Confusion Matrices (Using ENVI) | Exelis VIS Docs Center,” n.d.). 

Confusion Matrix (Pixels) 

The confusion matrix is calculated by comparing the location and class of each ground truth 
pixel with the corresponding location and class in the classification image. Each column of the 
confusion matrix represents a ground truth class and the values in the column correspond to the 
classification image’s labeling of the ground truth pixels. The confusion matrix was calculated for 
all satellite images. The results are shown in table in the results and analysis section of this 
report (“Calculate Confusion Matrices (Using ENVI) | Exelis VIS Docs Center,” n.d.). 

Confusion Matrix (Percent) 

The Ground Truth (Percent) table shows the class distribution in percent for each ground truth 
class. The values are calculated by dividing the pixel counts in each ground truth column by the 
total number of pixels in a given ground truth class. The percentages of the accuracies of each 
classes identified during the supervised classification are shown in tables. (“Calculate Confusion 
Matrices (Using ENVI) | Exelis VIS Docs Center,” n.d.). 

Error of Commission 

Errors of commission represent pixels that belong to another class that are labeled as belonging 
to the class of interest. The errors of commission are shown in the rows of the confusion matrix. 
The ratio of the number of pixels classified incorrectly by the total number of pixels in the ground 



truth class forms an error of commission (“Calculate Confusion Matrices (Using ENVI) | Exelis 
VIS Docs Center,” n.d.). 

Error of Omission 

Errors of omission represent pixels that belong to the ground truth class but the classification 
technique has failed to classify them into the proper class. The ratio of the number of pixels 
classified incorrectly by the total number of pixels in the ground truth class forms an error of 
omission (“Calculate Confusion Matrices (Using ENVI) | Exelis VIS Docs Center,” n.d.). 

Producer Accuracy 

The producer accuracy is a measure indicating the probability that the classifier has labeled an 
image pixel into Class A given that the ground truth is Class A (“Calculate Confusion Matrices 
(Using ENVI) | Exelis VIS Docs Center,” n.d.). 

User Accuracy 

User accuracy is a measure indicating the probability that a pixel is Class A given that the 
classifier has labeled the pixel into Class A. (“Calculate Confusion Matrices (Using ENVI) | 
Exelis VIS Docs Center,” n.d.). 

2.2.3 Change Detection Analysis 
Change Detection Analysis encompasses a broad range of methods used to identify, describe, 
and quantify differences between images of the same scene at different times or under different 
conditions. You can use many of ENVI's tools (such as Band Math or Principal Components 
Analysis) independently, or in combination, as part of a change detection analysis. In addition, 
the routines found under the Toolbox menu Change Detection offer a straightforward approach 
to measuring changes between a pair of images that represent an initial state and final state. 
Use Change Detection Statistics for classification images. 

Change Detection Statistics 

Use Change Detection Statistics to compile a detailed tabulation of changes between two 
classification images. The changes detected using this routine differ significantly from a simple 
differencing of the two images. While the statistics report does include a class-for-class image 
difference, the analysis focuses primarily on the initial state classification changes; that is, for 
each initial state class, the analysis identifies the classes into which those pixels changed in the 
final state image. ENVI can report changes as pixel counts, percentages, and areas. In addition, 
you can produce a special type of mask image (classification masks) that provide a spatial 
context for the tabular report. The class masks are ENVI classification images with class colors 
matching the final state image, making it easy to identify not only where changes occurred but 
also the class into which the pixels changed. 

The input images must be coregistered or georeferenced. For the most accurate results, 
carefully coregister the images before processing. If the input images are not coregistered, 
ENVI uses the available map information to automatically coregister the images, using the initial 
state image as the base if re-projection or resampling is required. 

    From the Toolbox, select Change Detection > Change Detection Statistics. 



    The Select the ‘Initial State’ Image dialog appears. 

    Select a classification image representing the initial state and perform optional spatial 
subsetting, then click OK. The Select the ‘Final State’ Image dialog appears. 

    Select a classification image representing the final state and perform optional spatial 
subsetting, then click OK. The Define Equivalent Classes dialog appears. 

    Match the classes from the Initial and final state images by selecting the matching names in 
the two lists and clicking Add Pair. 

    Add only the classes you wish to include in the change detection analysis (you do not have to 
pair all classes). The class combinations are shown in a list at the bottom of the dialog. If the 
classes in each image have the same names, they are automatically paired. 

    Click OK. The Change Detection Statistics Output dialog appears. 

    Select the Report Type. You may choose any combination of Pixels, Percent, and Area. 

    Click the Output Classification Mask Images? toggle button to specify whether or not to 
create class masks. 

    If the Output Classification Mask Images? toggle button is Yes, select output to File or 
Memory. 

    Click OK. If an Area Report was requested but the initial state image does not have pixel 
sizes defined, the Define Pixel Sizes for Area Statistics dialog displays. 

    Enter the pixel sizes. 

    Click OK. ENVI adds the resulting output to the Layer Manager and opens the statistics in the 
Change Detection Statistics window. 

The Change Detection Statistics Report 

The Change Detection Statistics window contains all of the statistics tables that you selected 
from the Report Type field in the Change Detection Statistics Output dialog box, separated by 
tabs. It also contains a Reference tab, which includes additional information about the analysis, 
such as the names of the input images and the equivalent class pairings. Below is a sample 
Change Detection Statistics Report. 

The statistics tables list the initial state classes in the columns and the final state classes in the 
rows. However, the columns include only the selected (paired) initial state classes, while the 
rows contain all of the final state classes. This is required for a complete accounting of the 
distribution of pixels that changed classes. For each initial state class (that is, each column), the 
table indicates how these pixels were classified in the final state image. For example, the table 
above shows that 999 pixels initially classified as "Estuarine Aquatic Bed" changed into the 
"Unconsolidated Shore" class in the final state image. 

    The Class Total row indicates the total number of pixels in each initial state class, and the 
Class Total column indicates the total number of pixels in each final state class. The table above 
shows that 211,633 pixels were classified as "Estuarine Aquatic Bed" in the initial state image. 



    The Row Total column is a class-by-class summation of all final state pixels that fell into the 
selected initial state classes. 

    Note: This may not be the same as the Final State Class Totals because it is not required that 
all initial state classes be included in the analysis. 

    The Class Changes row indicates the total number of initial state pixels that changed classes. 
In the table above, the total Class Changes for "Water" is 8,193 pixels. In other words, 8,193 
pixels that were initially classified as "Water" changed into final state classes other than water. 

    The Image Difference row is the difference in the total number of equivalently classed pixels 
in the two images, computed by subtracting the Initial State Class Totals from the Final State 
Class Totals. An Image Difference that is positive indicates that the class size increased. For 
example, in table above, the "Water" class grew by 467,119 pixels. 

Select the tabs along the top of the Change Detection Statistics dialog to show equivalent 
information for the class changes in terms of Percentage and Area. In the Percent report (not 
shown here) the increase in the size of the Water class corresponds to a growth of 21%: 

(final state - initial state) / initial state = (390381 - 322763) / 322763 = 0.209 

Additional Features of the Change Detection Statistics Report 

Options from the Change Detection Statistics Report dialog menu bar are: 

    To change the floating-point precision displayed in the report, select Options > Set Report 
Precision. 

    To convert the units for the Area report, select Options > Convert Area Units. 

    To save the statistics reports to an ASCII text file, select File > Save to Text File. The Save 
Change Detection Stats to Text dialog appears; you can optionally add a descriptive line of 
header text to the file being written. The data is saved in a tab delimited format to facilitate 
importing into other software programs. 

The Classification Mask Images 

The classification masks complement the statistics tables by spatially identifying which initial 
state pixels changed classes, and into which class they changed. By examining the masks, you 
can often see patterns of changes. The masks can also help highlight coregistration errors. 

ENVI saves the class mask images as a multi-band image with one mask for each paired class. 
To help identify the class into which a pixel changed, the masks are stored as ENVI 
classification images with the class assignments (names, colors, and values) matching the final 
state. A value of zero in the mask indicates that no change occurred from the initial to the final 
state; non-zero values indicate a change. 

To differentiate pixels that did not change classes from those that changed into the Unclassified 
class (which typically has a classification value of zero), pixels that changed into the 
Unclassified class are assigned a value equal to the number of final state classes plus one, and 
color coded white. For example, in the sample analysis shown in the figure above, the final state 



image contains 6 classes; therefore, any pixel in the mask that changed into the unclassified 
class would be assigned a value of 7. 

2.2.4 Majority/Minority Analysis 
The majority/minority analysis is used to apply majority or minority analysis to classification 
image. The majority filter analysis was used to change the spurious pixels within a large single 
class to that class. A 5 x 5 kernel size was used for this analysis. The center pixel in the kernel 
is replaced with the class value that the majority of the pixels in the kernel has. The majority 
filter was used to filter out the unnecessary pixels within the classified image. The results from 
this analysis is shown in the results and analysis section of this project 

3 Results and Analysis 
3.1 Image Classification 
3.1.1 1993 Image Classification 
Figures 4.1 and 4.2 shows the 1993 classified image and filtered classified image of Pasco 
County. The filtered Image shows a clearer picture of the 1993 land use and land cover image 
of Pasco County. Using the 5 x 5 majority filter, the 1993 classified image was filtered and 
cleaned to remove specs and falsely classified pixels. 

 
Fig 3.1: 1993 Supervised Classification 



 

Fig 4.2: 1993 Majority Filtered Classification of Pasco County 

3.1.1.1 Confusion Matrix 
The calculation of the overall accuracy of the 1993 image classification showed a 99.7415% 
accuracy of the pixels within the ROIs selected for each of the class. This result was further 
acknowledged when the result of the calculated kappa coefficient showed a 0.9916 score out of 
a possibility of 1. This overall accuracy and kappa coefficient were able to achieve this level of 
accuracy due to the careful extraction of the classes within the images. Another reason was 
because the classes generated for this analysis were more of a general purpose rather than 
show more detail image classes 
 
From tables the below, it can be observed that all classes have a high degree of accuracy. 
None of the classes generated was lower than 90 percent. Of the 5 classes forest and wetlands 
recorded the lowest with 98.45% and 98.62% level of accuracy respectively. This level of 
accuracy 
 
Table 3.1: Ground truth Pixels 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area 7520 4 73 62 1 7660 
Forest 0 7371 0 0 42 7413 
Grassland 50 10 6752 0 0 6812 
Water 0 0 0 118824 0 118824 
Wetlands 0 102 2 26 3074 3204 
Total 7570 7487 6827 118912 3117 143913 
 



Table 3.2: Ground truth Percentage 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area 99.34 0.05 1.07 0.05 0.03 5.32 
Forest 0 98.45 0 0 1.35 5.15 
Grassland 0.66 0.13 98.9 0 0 4.73 
Water 0 0 0 99.93 0 82.57 
Wetlands 0 1.36 0.03 0.02 98.62 2.23 
Total 100 100 100 100 100 100 
3.1.1.2 Errors of Omission and Commission 
The table below shows that wetlands had the highest percentage of commission error with a 
percentage of 4.06 (130/3204 pixels), while forest had the highest percentage in omission with a 
percentage of 1.55% (116/7487). This means that 4.06% of other classes were classified in 
error as wetlands while the classifier classified 1.55% of other classes as forest. The other 
percentages 

Table 3.3: Errors of commission and omission 
Class Commission (Percent) Omission (Percent) Commission (Pixels) Omission (Pixels) 
Built Up Area 1.83 0.66 140/7660 50/7570 
Forest 0.57 1.55 42/7413 116/7487 
Grassland 0.88 1.1 60/6812 75/6827 
Water 0 0.07 0/118824 88/118912 
Wetlands 4.06 1.38 130/3204 43/3117 
 

3.1.1.3 Producer and User Accuracies 
The table below shows very high accuracies in both the producer and user accuracies. 
None of accuracies fell below 0.5 level of error during class. The table below shows the 
levels of producer and user accuracies for the 1993 image classification. 
 

Table 3.4: Producer and user accuracies 
Class Prod. Acc. (Percent) User Acc. (Percent) Prod.Acc. (Pixels) User Acc. (Pixels) 
Built Up Area 99.34 98.17 7520/7570 7520/7660 
Forest 98.45 99.43 7371/7487 7371/7413 
Grassland 98.9 99.12 6752/6827 6752/6812 
Water 99.93 100 118824/118912 118824/118824 
Wetlands 98.62 95.94 3074/3117 3074/3204 
 



3.1.2 1998 Image Classification 

 
Fig: 3.3: 1998 Classified Image of Pasco County 

 
Fig.3.4: 1998 Majority Filtered Classification of Pasco County 



3.1.2.1 Confusion Matrix 
The confusion matrix calculation of the 1998 satellite image of Pasco County showed an overall 
accuracy of 99.1% and a kappa coefficient of 0.9871. This result shows a highly accurate and 
precise classification of the satellite image. This result was further substantiated with the 
breakdown of the accuracies of each of the classes shown in tables 4.5 and 4.6. The result 
showed that none of classes fell below the 95% accuracy mark. Of the five classes, forest was 
recoded to have the lowest with 97.26% of the pixels selected being accurate. 
 

Table 3.5: Ground truth Pixels 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area          5889 1 3 1 0 5894 
Forest            0 11556 0 0 69 11625 
Grassland         0 1 3809 0 0 3810 
Water 0 1 0 20198 0 20199 
Wetlands 0 323 0 0 2636 2959 
Total 5889 11882 3812 20199 2705 44487 
 

Table 3.6: Ground Truth Percentage 
Class     Built Up Area Forest.sh Grassland Water Wetlands Total   
Built Up Area 100 0.01 0.08 0 0 13.25 
Forest 0 97.26 0 0 2.55 26.13 
Grassland   0 0.01 99.92 0 0 8.56 
Water 0 0.01 0 100 0 45.4 
Wetlands 0 2.72 0 0 97.45 6.65 
Total        100 100 100 100 100 100 
 

3.1.2.2 Errors of Omission and Commission 
The errors of commission shows that wetlands had a commission error of 10.92 percent; Built-
Up Area, Forest and Grassland all had errors less than 1% while water had no error or 
commission at all. Built-up Area and Water had no error of omission, while Grassland had less 
than one percent of omission error and forest and wetlands had the highest omission of 2.74% 
and 2.55% respectively. 

Table 3.7: Errors of commission and omission 
Class    Commission (Percent) Omission (Percent) Commission (Pixels) Omission (Pixels) 
Built Up Area          0.08 0 5/5894 0/5889 
Forest          0.59 2.74 69/11625 326/11882 
Grassland          0.03 0.08 1/3810 3/3812 
Water          0 0 1/20199 1/20199 
Wetlands         10.92 2.55 323/2959 69/2705 
 



3.1.2.3 Producers and Users Accuracies 
The producer and user accuracies show a high level of accuracies with built-up area and water 
having a 100% producer accuracy level respectively, while water has a user accuracy of 100%. 
None of the accuracies of the classes in this land use and land cover analysis recorded an 
accuracy level that was less than 95%. 

Table 3.8: Producer and user accuracies 
        Class    Prod. Acc. (Percent) User Acc. (Percent) Prod. Acc. (Pixels) User Acc. (Pixels) 
Built Up Area        100 99.92 5889/5889 5889/5894 
Forest         97.26 99.41 11556/11882 11556/11625 
Grassland         99.92 99.97 3809/3812 3809/3810 
Water        100 100 20198/20199 20198/20199 
Wetlands         97.45 89.08 2636/2705 2636/2959 
 

3.1.3 2003 Image Classification 

 
Fig: 3.5: 2003 Classified Image of Pasco County 

 



 
Fig.3.6: 2003 Majority Filtered Classification of Pasco County 

3.1.3.1 Confusion Matrix 
The confusion matrix calculation of the 2003 land use and land cover classified image showed 
an overall accuracy of 98.86% and a kappa coefficient of 0.9764. The ground truth showed that 
the forest class had the lowest percentage of 94.68% with water ranking as the highest 
percentage of 99.91%. Other details about the ground truth accuracies are shown in tables 4.9 
and 4.10. 
 
Table 3.9: Ground Truth Pixels 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area 5319 0 25 31 0 5375 
Forest 0 15422 0 0 40 15462 
Grassland 71 9 5672 0 0 5752 
Water 0 0 0 55980 0 55980 
Wetlands 0 858 0 18 1647 2523 
Total          5390 16289 5697 56029 1687 85092 
 

Table 3.10: Ground truth percentages 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area         98.68 0 0.44 0.06 0 6.32 
Forest      0 94.68 0 0 2.37 18.17 
Grassland 1.32 0.06 99.56 0 0 6.76 
Water 0 0 0 99.91 0 65.79 



 Wetlands 0 5.27 0 0.03 97.63 2.97 
Total        100 100 100 100 100 100 
 

3.1.3.2 Errors of Omission and Commission 
The table below shows that wetlands had the highest error of commission with a total of 34.72% 
being classified as another class. Water had the lowest error with no error at all. Forest and 
wetlands had the highest errors of omission of 5.32% and 2.37% respectively. Other classes 
had less than 2% errors o omission. 

Table 3.11: Errors of commission and omission 
Class Commission (Percent) Omission (Percent) Commission (Pixels) Omission (Pixels) 
Built Up Area          1.04 1.32 56/5375 71/5390 
Forest  0.26 5.32 40/15462 867/16289 
Grassland  1.39 0.44 80/5752 25/5697 
Water  0 0.09 0/55980 49/56029 
Wetlands 34.72 2.37 876/2523 40/1687 

 

3.1.3.3 Producers and Users Accuracies 
The producers accuracies had a high level of accuracy with the lowest being forest with a level 
of 94.68% of accuracy. Wetlands on the other hand had the lowest level of user accuracy of 
65.28% level of accuracy. This was one of the lowest level of accuracy ever recorded in the all 
the satellite images that were classified. 

Table 3.12: Producer and user accuracies 
Class  Prod. Acc. (Percent) User Acc. (Percent) Prod. Acc. (Pixels) User Acc. (Pixels) 
Built Up Area         98.68 98.96 5319/5390 5319/5375 
Forest  94.68 99.74 15422/16289 15422/15462 
Grassland  99.56 98.61 5672/5697 5672/5752 
Water  99.91 100 55980/56029 55980/55980 
Wetlands  97.63 65.28 1647/1687 1647/2523 



3.1.4 2008 Image Classification 

 
Fig: 3.7: 2008 Classified Image of Pasco County 

 
Fig. 3.8: 2008 Majority Filtered Classification of Pasco County 



3.1.4.1 Confusion Matrix 
The confusion matrix calculation of the 2008 land use and land cover classification showed that 
the overall accuracy of the classification was 98.7% and the kappa coefficient was 0.9778. This 
showed that the classification of the 2008 satellite image was very accurate. Tables 4.13 and 
4.14 shows the breakdown of accuracies of the land use classes used for this classification. 
From the tables below, it can be observed that none of the land use classes accuracy level fell 
below 95%. 

Table 3.13: Ground truth pixels 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area 6988 0 10 7 0 7005 
Forest 0 28648 0 6 24 28678 
Grassland 4 100 4302 37 1 4444 
Water 0 0 0 55917 0 55917 
Wetlands 0 1023 10 62 1662 2757 
Total 6992 29771 4322 56029 1687 98801 
 

Table 3.14: Ground truth percentages 
Class Built Up Area Forest Grassland Water Wetlands Total 
Built Up Area 99.94 0 0.23 0.01 0 7.09 
Forest 0 96.23 0 0.01 1.42 29.03 
Grassland 0.06 0.34 99.54 0.07 0.06 4.5 
Water 0 0 0 99.8 0 56.6 
Wetlands 0 3.44 0.23 0.11 98.52 2.79 
Total 100 100 100 100 100 100 
 

3.1.4.2 Errors of Omission and Commission 
The errors o commission showed that wetland had the highest level of error of 39.72%. This 
indicates that almost 40% of the pixels selected in the land use class belonged to another class, 
most likely forest and grassland. Water had the lowest level of error with no error of 
commission. The errors of omission were all pretty low. All errors of omission for the 2008 
image classification did not go above the 5% mark with forest having the highest level of error 
and built-up area as having the lowest. 

Table 3.15: Errors of commission and omission 
        Class    Commission (Percent) Omission  (Percent) Commission (Pixels) Omission (Pixels) 
Built Up Area 0.24 0.06 17/7005 4/6992 
Forest 0.1 3.77 30/28678 1123/29771 
Grassland 3.2 0.46 142/4444 20/4322 
Water 0 0.2 0/55917 112/56029 
Wetlands 39.72 1.48 1095/2757 25/1687 
 



3.1.4.3 Producers and Users Accuracies 
The producers accuracy recorded a high level of probability no less that 95%. This indicated 
that all land use classes were properly classed. In the users accuracy however, wetlands had a 
low probability of 60.28% that the pixels selected for that class actually belonged to that class. 
All the other classes had a much higher probability rate. 

Table 3.16: Producer and user accuracies 
        Class    Prod. Acc.(Percent) User Acc.(Percent) Prod. Acc.(Pixels) User Acc.(Pixels) 
Built Up Area 99.94 99.76 6988/6992 6988/7005 
Forest 96.23 99.9 28648/29771 28648/28678 
Grassland 99.54 96.8 4302/4322 4302/4444 
Water 99.8 100 55917/56029 55917/55917 
Wetlands 98.52 60.28 1662/1687 1662/2757 
 

3.1.5 2013 Image Classification 

 
Fig: 3.9: 2013 Classified Image of Pasco County 



 

 
Fig.3.10: 2013 Majority Filtered Classification of Pasco County 

3.1.5.1 Confusion Matrix 
The confusion matrix calculation for the 2013 classified image showed an overall accuracy of 
99.6% and a kappa coefficient of 0.9905. The breakdown of the accuracies of each land use 
classes and their percentages are shown in tables 4.17 and 4.18 

Table 3.17: Ground truth pixels 
Class     Built Up Area Forest Grassland Water Wetlands Total   
Built Up Area 7831 216 39 9 2 8097 
Forest 0 19921 9 31 13 19974 
Grassland 7 49 4404 0 2 4462 
Water 0 0 0 112934 0 112934 
Wetlands 0 123 0 30 897 1050 
Total          7838 20309 4452 113004 914 146517 
 

Table 4.18: Ground truth percentages 
Class Built Up Area Forest Grassland Water Wetlands Total   
Built Up Area 99.91 1.06 0.88 0.01 0.22 5.53 
Forest  0 98.09 0.2 0.03 1.42 13.63 
Grassland 0.09 0.24 98.92 0 0.22 3.05 
Water 0 0 0 99.94 0 77.08 
Wetlands 0 0.61 0 0.03 98.14 0.72 



Total 100 100 100 100 100 100 
 

3.1.5.2 Errors of Omission and Commission 
The table below shows that the errors of omission and commission all recorded low numbers of 
errors except for wetlands which recorded a level of 14.57% in errors of commission. This 
indicated that about 15% of the total pixels selected for this land use class belonged to another 
class. 

Table 3.19: Errors of commission and omission 
Class Commission (Percent) Omission (Percent) Commission (Pixels) Omission (Pixels) 
Built Up Area 3.29 0.09 266/8097 7/7838 
Forest 0.27 1.91 53/19974 388/20309 
Grassland 1.3 1.08 58/4462 48/4452 
Water 0 0.06 0/112934 70/113004 
Wetlands 14.57 1.86 153/1050 17/914 
 

3.1.5.3 Producers and Users Accuracies 
The producers and users accuracies all recorded a high level of probability that the pixels 
selected belonged to the right group. All except wetlands in the user accuracy were in the high 
90s. 

Table 3.20: Producer and user accuracies 
Class Prod. Acc. (Percent) User Acc. (Percent) Prod. Acc. (Pixels) User Acc. (Pixels) 
Built Up Area  99.91 96.71 7831/7838 7831/8097 
Forest 98.09 99.73 19921/20309 19921/19974 
Grassland  98.92 98.7 4404/4452 4404/4462 
Water 99.94 100 112934/113004 112934/112934 
Wetlands 98.14 85.43 897/914 897/1050 
 

3.2 Change Detection 
The figures and tables below shows the changes in the land use and land cover over a 5 year 
interval for the past 20 years. This gives a clear description as to what land cover changed and 
to what it changed into. The change detections are measured in square miles and percentages. 
With this analysis we can begin to see the various levels of change that occurred as the years 
progressed. 



3.2.1 1993-1998 Change 

 
Fig. 3.11: 1993 – 1998 Changed Areas 

Figure 4.11 shows the section within the county that changed in terms of land cover 
between 1993 and 1998. The sections with the gray color are those with no change. It 
can be observed that moves of the change occurred around forest and grassland areas. 

From the table below it can be observed that of the five land cover classes built up area 
had the largest net gain with a total of 143.05 sq. miles. This was an 88 percent gain 
from its original size. All the other land cover classes all had net losses of various sizes 
in sq. miles and percentages. These results can be seem in tables 4.21 and 4.22 

Table 3.21: Area Change of Land Use Type from 1993 to 1998 
Area (Sq. Miles) Built Up Area Wetlands Water Grassland Forest Row Total Class Total 
Built Up Area 135.99 35.45 5.04 87.73 40.07 304.28 304.28 

Wetlands 2.46 70.57 0.04 3.67 27.88 104.63 104.63 

Water 0.29 2.39 166.62 0.09 0.02 169.41 169.41 

Grassland 14.59 3.85 0 210.1 4.16 232.7 232.7 

Forest 7.9 34.53 0 14.31 186.92 243.67 243.67 

Class Total 161.23 146.8 171.7 315.9 259.05 0 0 

Class Changes 25.24 76.23 5.08 105.8 72.13 0 0 

Image Difference 143.05 -42.17 -2.29 -83.2 -15.38 0 0 
 

 



Table 3.22: Percentage Change of Land Use Type from 1993 to 1998 

Percentages Built Up Area Wetlands Water Grassland Forest Row Total 
Class 
Total 

Built Up Area 84.344 24.151 2.933 27.772 15.468 100 100 
Wetlands 1.527 48.075 0.022 1.163 10.763 100 100 
Water 0.183 1.626 97.042 0.028 0.008 100 100 
Grassland 9.046 2.625 0 66.509 1.605 100 100 
Forest 4.901 23.522 0.003 4.529 72.157 100 100 
Class Total 100 100 100 100 100 0 0 
Class Changes 15.656 51.925 2.958 33.491 27.843 0 0 
Image Difference 88.72 -28.727 -1.333 -26.338 -5.939 0 0 
 

3.2.2 1998-2003 Change 

 
Fig .3.12: 1998 – 2003 Changed Areas 

From the figure above it can be observed that a large area of the county had changed from 
other land use classes in to mainly grassland and forest. This can also be observed in the table 
below which shows that grassland and forest both had a positive gain and built up area and 
wetland both had negative changes. This means that the grassland and forest gain and built up 
area and wetlands lost. 

Table 3.23: Area Change of Land Use Type from 1998-2003 



 

Table 3.24: Percentage Change of Land Use Type from 1998-2003 
Percentages Built Up Area Wetlands Water Grassland Forest Row Total Class Total 
Built Up Area 36.992 1.346 0.081 6.161 2.491 100 100 
Wetlands 5.05 40.277 1.306 0.775 2.246 100 100 
Water 2.318 0.421 98.51 0.202 0.029 100 100 
Grassland 36.584 5.399 0.017 87.627 11.727 100 100 
Forest 19.056 52.556 0.086 5.235 83.508 100 100 
Class Total 100 100 100 100 100 0 0 
Class Changes 63.008 59.723 1.49 12.373 16.492 0 0 
Image Difference -55.794 -35.967 3.252 50.186 34.93 0 0 
 

3.2.3 2003-2008 Change 

 
Fig.4.13: 2003 – 2008 Changed Areas 

Area (Sq. Miles) Built Up Area Wetlands Water Grassland Forest Row Total Class Total 
Built Up Area 112.56 1.41 0.14 14.34 6.07 134.51 134.51 
Wetlands 15.37 42.14 2.21 1.8 5.47 67 67 
Water 7.05 0.44 166.88 0.47 0.07 174.92 174.92 
Grassland 111.32 5.65 0.03 203.9 28.57 349.48 349.48 
Forest 57.98 54.99 0.15 12.18 203.48 328.78 328.78 
Class Total 304.28 104.63 169.41 232.7 243.67 0 0 
Class Changes 191.72 62.49 2.52 28.79 40.19 0 0 
Image Difference -169.77 -37.63 5.51 116.78 85.11 0 0 



The figure above shows the areas and land use class where changes had taken place. 
This shows that most of the areas which experience change were areas previously 
recognized as mostly forests. This is further explained in tables 4.25 and 4.26. The 
tables below shows that all land use classes except for forest had positive gains. Forest 
on the other hand lost a total of 197.9 sq miles to other land use classes. This 
constitutes about 60% of the total forest cover in the county. One thing to note is that 
this may not be entirely correct as the classifier may have misclassified some forest 
areas as wetland and grassland. This may have occurred due to the time and date of 
the image capture. The full details of the land use change between 2003 and 2008 are 
shown in tables below. 

Table 3.25: Area Change of Land Use Type from 2003-2008 
Area (Sq. Miles) Built Up Area Wetlands Water Grassland Forest Row Total Class Total 
Built Up Area 107.58 2.42 0.36 54.12 17.46 181.95 181.95 
Wetlands 3.26 39.27 2.34 10.11 107.36 162.33 162.33 
Water 1.25 2.5 171.35 0.23 0.22 175.55 175.55 
Grassland 22.24 6.96 0.82 282.49 91.46 403.97 403.97 
Forest 0.19 15.85 0.05 2.51 112.29 130.88 130.88 
Class Total 134.51 67 174.92 349.48 328.78 0 0 
Class Changes 26.93 27.73 3.57 66.98 216.49 0 0 
Image Difference 47.44 95.34 0.63 54.5 -197.9 0 0 
 

Table 3.26: Percentage Change of Land Use Type from 2003-2008 
Percentages Built Up Area Wetlands Water Grassland Forest Row Total Class Total 
Built Up Area 79.981 3.61 0.205 15.487 5.311 100 100 
Wetlands 2.421 58.615 1.336 2.894 32.653 100 100 
Water 0.926 3.732 97.961 0.066 0.067 100 100 
Grassland 16.531 10.39 0.472 80.834 27.817 100 100 
Forest 0.141 23.654 0.026 0.719 34.152 100 100 
Class Total 100 100 100 100 100 0 0 
Class Changes 20.019 41.385 2.039 19.166 65.848 0 0 
Image Difference 35.266 142.303 0.36 15.593 -60.192 0 0 
 



3.2.4 2008-2013 Change 

 
Fig .3.12: 2008 – 2013 Changed Areas 

The figure above shows the sections and land use classes that changed and where the change 
took place. From the figure above it can the seen that the most dominant change ws between 
built up area and forest land use classes. This can further be seen in tables 3.27 and 3.28. from 
the tables, it can be observed that  built up area and forest had positive changes with 88.68 sq.  
Miles and 182.39 sq.miles being added to these land use classes respectively. Wetland, water 
and grassland had net losses with grassland losing the biggest chunk of it all (-153.14 sq. 
miles).Grassland in particular lost most of its class to built-up area and forest. One attribution to 
this is the sudden expansion of houses, both residential and commercial, after the recession. 

Table 3.27: Percentage Change of Land Use Type from 2008-2013 
Area (Sq. Miles) Built Up Area Wetlands Water Grassland Forest Row Total Class Total 

Built Up Area 150.13 22.5 4.28 91.68 2.04 270.63 270.63 

Wetlands 2.91 33.56 0.9 8.27 2.53 48.17 48.17 

Water 0.18 1.06 170.07 0.45 0.01 171.77 171.77 

Grassland 19.21 9.04 0.02 220.57 1.99 250.83 250.83 

Forest 9.52 96.17 0.28 83 124.3 313.27 313.27 

Class Total 181.95 162.33 175.55 403.97 130.88 0 0 

Class Changes 31.81 128.77 5.48 183.4 6.58 0 0 

Image Difference 88.68 -114.16 -3.77 -153.14 182.39 0 0 
 

 



Table 3.28: Percentage Change of Land Use Type from 2008-2013 
Percentages Built Up Area Wetlands Water Grassland Forest Row Total Class Total 
Built Up Area 82.515 13.862 2.437 22.694 1.56 100 100 
Wetlands 1.599 20.676 0.512 2.046 1.934 100 100 
Water 0.1 0.653 96.878 0.112 0.011 100 100 
Grassland 10.555 5.568 0.012 54.602 1.523 100 100 
Forest 5.231 59.241 0.161 20.546 94.971 100 100 
Class Total 100 100 100 100 100 0 0 
Class Changes 17.485 79.324 3.122 45.398 5.029 0 0 
Image Difference 48.742 -70.326 -2.15 -37.908 139.356 0 0 
 

4 Conclusion 
This project examined the land cover change of Pasco County, Florida over a 20 year period 
(1993-2013). Five satellite images were classified using a 1993, 1998, 2003, and 2008 TM 
Landsat satellite, and a 2013 OLI/TIRS Landsat Image. The classification accuracy of all five 
classified image was assessed by comparing the result of the classes with images obtained 
from Google Earth high resolution images. The overall accuracies for both images was above 
90 percent while the Kappa Coefficient for both images were above 0.9, which indicates that the 
classification was highly accurate. The results from the confusion matrix, errors of omission and 
commission, and Producers and users accuracies also proved that the classification was also 
very high. 

Using the change detection analysis, it was observed that there were different levels of change 
over the 20 year period. All land cover types/classes at one point or the other gained from other 
land use types and at other points lost to other classes. 

This land cover data would provide detailed information for the county administrators on how 
much the county land cover has changed and by how much it has changed. It will also assist 
conservationist on what kind of land cover to concentrate on and how to manage these 
resources so they don’t get depleted and save it for future generations. 
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